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Introduction

Welcome to Advanced DataBlock Designer Training
Welcome to the Advanced DataBlock Designer training sessions for Argos. As you
move through the exercises that follow, you will learn how to use some of the more

advanced DataBlock features. These exercises will give you practice using
advanced user input controls, charts and drill downs, and OLAP cubes.

Important Note About This Workbook

This is a continuation of the Basic DataBlock Designer Workbook. The exercises in
this workbook are based upon the exercises in the Basic Designer workbook.
Several of the exercises that follow will build on the DataBlocks you created in the
Basic Designer sessions. You will need to have completed all of the Basic Designer
exercises before continuing on with this workbook.

NOTE: If you need a refresher on any of the term definitions we use in this workbook,
please refer to the glossary in the Basic Designer workbook.
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Fourth Exercise: Advanced DataBlock 1 — Address List for
Admitted Students

Advanced Datablock 1 - Address List for Admitted Students argos'

powered by ' EVISIONS

Find Addresses for Admitted Students

Select Admission Acceptance Type Select Term:

[include all types |200940 - Surmmer 2 2009

Early Admission
Early Decision Select Address Type
Special Program

Standard |

Products Training Support  Feedback WWw.evisions.com

Exercise Description

In this exercise we are going to copy the DataBlock we created in the first exercise from the Basic Workbook and
edit it to add more sophisticated functionality. The updated DataBlock will include a new checkbox variable that
uses a union to allow users to select all of the options in a list box with one click. You will then add a correlated
subquery and a scalar subquery to your report query.

For this exercise, you will only be adding one new variable:

Include all Admission Types — checkbox that a user can check to automatically select all the admission types in
the Admissions Type list box
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Instructions

Copy the ‘Address List for Admitted Students’ DataBlock

1. Find the DataBlock you created in the first exercise, Address List for Admitted Students.

NOTE: If you did not complete Exercise 1, you can request a copy of the DataBlock from the instructor.

2. Right-click on the DataBlock in the Explorer tab, and choose Copy from the menu.
NOTE: If the view needs to be refreshed, the Copy function will appear grayed out and won't be available. If
this happens, click on a different object (folder or DataBlock) in the Explorer tab and then right-click on the
‘Address List for Admitted Students’ DataBlock, and try clicking Copy again.
Click on your user folder to highlight it.
Right-click on your folder, and choose Paste from the menu.
Click the Paste button in the Paste window that appears.
In the Explorer tab, click the name of the new DataBlock and rename it: ‘Advanced Address List for
Admitted Students’.
7. Click the Edit button to open the DataBlock Designer.

o v AW

Add the ‘Include All Types’ checkbox
8. Click the Add Check Box tool (the button in the toolbar that shows a box with an ‘X" in it)
9. Click on the panel to add the button.
10. On the Properties tab:
a. Nextto Checked Value, type 'Y’
b. Nextto Text, type ‘Include all types’
c.  Next to UnChecked Value, type ‘N’
d. Nextto Variable Name, type ‘main_CB_AdmitType’
11. Move the Admissions Type list box (main_LB_AcceptCode) down so there is room between it and its
label for you to add the checkbox.
12. Move the checkbox under the list box label, ‘Select Admission Acceptance Type'.
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Modify the SQL in the ‘Admissions Acceptance Type’ list box

We are going to modify the SQL in the Admission Acceptance Type List Box (‘main_LB_AcceptCode’) to use the
checkbox we just created as a variable. If the user does not want to restrict the resulting data set by a particular
acceptance type, they can check the box to include students of all acceptance types. If they do want to choose
(and therefore restrict by) acceptance type, they can leave the box unchecked, and they can choose an acceptance
type (or types) from the list box.

select Admission Acceptance Type Select Admission Acceptance Type

Clnclude all types M Include all types

Early Admission
Early Decision
Special Prograrm

standard
Figure 1: With the box unchecked, the list box shows Figure 2: With the box checked, the user does not have
the list of admission acceptance types, allowing the to select an admission acceptance type, and all types
user to choose which type they want. will be returned in the data set.

13. Before we modify the SQL we need to make one change to the list box. On the Properties tab:

a. Next to Auto Select, choose ‘Yes'.
14. Modify the list box SQL query that supplies the list of acceptance types for the list box
a. Double click on the list box.
i. Open the Visual Designer.

(M

Click on the Conditional Fields (WHERE) tab:
(a) Click in the and/or row and select: and
(b) Click in the Field row and click the ellipsis button to open the SQL Editor:
(i) Click the User-Defined Variable button (the ABC button on the toolbar) to bring
up a list of DataBlock variables:
1) Select ‘main_CB_AdmitType’
2) Click the OK button.
(ii) Backin the SQL Editor window, click the OK button again.
(c) Clickin the Condition row and type: ='N’
Click on the Ordering (ORDER BY) tab:
(@) Click in the Table row in the first column, where it says ‘'STVADMT," and choose
‘<calculated>’
(b) Inthe Field row, type ‘2’
Click on the Show Unions button at the top of the window, which will open the Unions
panel on the left side of the screen:
NOTE: If you would like more information on unions, please consult a SQL reference guide.
(a) Click on the Add Union button (the blue circle icon on the Union tab toolbar).
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Unions

@0 © 0 x

(b) Select ‘Main Query’ from the list in the Union tab.
(c) Click the Copy button (the icon with the stack of pages on the Union tab toolbar).

Unions

@000 x
©e =2 A

NOTE: DO NOT click on the Copy button in the main toolbar; that will copy the entire Visual
Design.
(d) Click the ‘Union” query in the list (below where it says ‘Main Query’) to select it.
(e) Click the Paste button (the clipboard icon on the Union tab toolbar), to paste a copy
of the main query into your union query.
(f)  With the ‘Union’ query highlighted, click on the Visible Fields (SELECT) tab:
(i) Clickin the Table row in the first column, where it says ‘STVADMT," and choose
‘<calculated>’
(ii) Click in the Field row of the first column and type: ‘Dummy Code’
NOTE: In this case, you'll include the single quotes when you type the text above.
(iii) Click in the Table row of the second column and choose ‘<calculated>’
(iv) Click in the Field row of the second column and type ‘Include all Acceptance
Types' (also including the single quotes).
(g) Click on the Conditional Fields (WHERE) tab:
(i) Inthe Condition row, changeitto: =Y’
ii. Click the OK button to exit the Visual Designer.
b. Review the SQL query you just built. It should look like this:

4. Choice Entry

This is the 0L skatement that will retrieve the choices For the end-user, Each "SELECT" field will become a
sub-variable, The associated visual design will nok reflect any changes made here,
select STVADMT.3TVADMT CODE "idmissTypeCode",
STVADNT. 3TVADNMT DE3C "hdwissType"
from 3ATURN.3TVADMT 3ITVADMT
where :main CB AdwitType = '
union
select 'Dunmmy Code' "AdmissTypecCode'™,
'Thelude All Acceptance Types! "hdmissType™
from FATURN.3TVADMT ITVADMT
where :main CE AdmitType = '¥T!

order by 2

{@ Edit Wisual Design SO Edit SQL Text
Connection: <default= [ Scripk returns recordset Edit A00 properties

[ <- Back H Mexk -= H Finish ]’ Cancel

c. Click the Next button.
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d. Click the OK button on the Test Values window.
e. On the next screen, provided there were no errors, hit the Finish button.

15. Commit and test your changes.
NOTE: At this point you cannot test your report query. We have changed the variable the report query is
based on, and we have not yet updated the report query to match. For the moment, you only need to test
that the checkbox and Acceptance Type list box are behaving correctly. The first row in the list box should be
highlighted, indicating that the box is automatically selecting the first result. With the checkbox unchecked,
you should see a listing of acceptance types. With the checkbox checked, the list box should simply say
‘Include All Acceptance Types'.

Modify the Report Query to include the ‘Include All Types’ checkbox
16. Click on the Report Query — Visual Design tab:
a. Click on the Conditional Fields (WHERE) tab:
i. Find the 'SARADAP_ADMT_CODE’ condition and delete it by clicking the X button at the top of
the column.

In the lower left-hand corner of the tab, click on the + button to create a conditional group:

(M

(2)

(5)

You now have a new conditional group under your root query. Select the group, double-
click 'SARADAP_ADMT_CODE' in the ‘'SARADAP’ table to add it to the conditional group.
Click in the Condition row and click the ellipsis button to open the SQL Editor:
(@) Click the User-Defined Variable button (the ABC button on the toolbar) to bring up a
list of DataBlock variables:
1) Select ‘main_LB_AcceptCode.AdmissTypeCode’
2) Click the OK button.
In the second column of your conditional group, click in the and/or row and select ‘or’
NOTE: Make sure you select ‘or’ not ‘and’ or this condition won't work.
Click in the Field row and click the ellipsis button to open the SQL Editor:
(a) Click the User-Defined Variable button (the ABC button on the toolbar) to bring up a
list of DataBlock variables:
(i) Select‘main_CB_AdmitType’
(i) Click the OK button.
(b) Back in the SQL Editor, click the OK button.
Click in the Condition row and type: =Y’

17. Commit and test your changes.
NOTE: When you test, if you check the checkbox you should get all types of admission types. If you uncheck
the box you should only get students that match the admit types that you selected. Close the preview when

done.
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Modify the Report Query to create a scalar subquery

We're going to add a scalar subquery to the SELECT clause of the Report Query. Specifically, we are going to add
‘STVLEVL_DESC' to the SELECT clause so we can see the student level description. Using a scalar subquery allows
us to do that without adding the entire table just for that one field.

NOTE: For more information on scalar subqueries, please consult a SQL reference guide.

18. Click on the Report Query — Visual Design tab:
a. Click on the Visible Fields (SELECT) tab, and scroll to the empty column all the way to the right.
b. Clickin the Table row and select ‘<calculated>’
c. Clickin the Field row and click the ellipsis button to bring up the SQL Editor:
i. Type the following:

(select STVLEVL_DESC
from STVLEVL
where SARADAP_LEVL_CODE=STVLEVL_CODE and rownum=1)

NOTE: Line breaks and spacing do not affect the way the SQL query runs. You can type everything on
one row or several, depending on what is more readable.

ii. Click the OK button to exit the SQL Editor
d. Clickin the As row and change ‘calc1’ to ‘LevelDesc’
19. Commit and test your changes.
NOTE: Make sure the subquery is working by checking that the student level description is appearing.

Modify the Report Query to create a correlated subquery

We're also going to add a correlated subquery to the WHERE clause of the Report Query. We want to modify the
resulting data set to only use the information from the student’s current application.
NOTE: For more information on subqueries, please consult a SQL reference guide.

20. Click on the Report Query — Visual Design tab:
a. Click the Sub Query button at the top of the tab, which will open up a new, blank, visual design
window:
i. Add table:'SARADAP’
NOTE: The alias for the new table will default to 'SARADAP1’ in order to distinguish it from the
'SARADAP' table that has already been added to the main query.
ii. Add'SARADAP_APPL_NO' to the Visible Fields (SELECT) tab.
(1) Click on the Summing button on the left side of the tab, and choose ‘Max’ in the
Summing row
iii. Add’SARADAP_PIDM' to the Conditional Fields (WHERE) tab.
(1) Click in the Condition row and click the ellipsis button to open the SQL Editor:
(i) Click the Insert Field button (the green neutron on the toolbar) to open the Pick
a Field window:
1) Click the + button to expand out ‘'SARADAP’
NOTE: Be very careful to choose 'SARADAP’, and NOT ‘SARADAP1’ in this step.
2) Click 'SARADAP_PIDM'’ to select it.
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3) Click the OK button.
(i) Backin the SQL Editor, click the OK button to close the window.
iv. Add‘SARADAP_TERM_CODE_ENTRY’ to the Conditional Fields (WHERE) tab.
(1) Click in the Condition row and click the ellipsis button to open the SQL Editor:
(i) Click the Insert Field button (the green neutron on the toolbar) to open the Pick
a Field window:
1) Click the + button to expand out ‘SARADAP’
NOTE: Again, be careful to choose ‘SARADAP’, and NOT 'SARADAPT'.
2) Click 'SARADAP_TERM_CODE_ENTRY’ to select it.
3) Click the OK button.
(2) Backin the SQL Editor, click the OK button to close the window.
v. Click the OK button to close out of the Sub Query window.
b. You will now see a new box, called ‘Query’, has been added to the table area of the Report Query —
Visual Design tab.
NOTE: If you want to rename the new ‘Query’ box—which can come in handy when you start adding
multiple subqueries—click on the Edit Query Properties button (the hardhat and hammer) on the
‘Query’ box toolbar. In the bottom left hand corner is the Rename button. Click the button to rename the
query box. Renaming the query box has no impact on the SQL, but it does make it easier to manage if
you have large numbers of subqueries.
i. Click the Add to Conditional Fields Tree button (the window icon with the green plus on the
‘Query’ box toolbar)

to add your correlated subquery to the Conditional Fields (WHERE) tab.
ii. On the Conditional Fields (WHERE) tab:
(1) Inthe conditional fields tree on the left, you'll see a new condition called ‘<query>". Click to

select it.
(2) Click the radio button for '=/,
Sub Query: Max_APP_No «—"_‘
EXISTS NOT EXISTS IN NOT IN < <= @ = Te= > =

which will display a new column of information about your new condition.
(3) Click in the Field row, and click the ellipsis button to open the SQL Editor:
(@) Click the Insert Field button (the green neutron on the toolbar) to open the Pick a
Field window:

1) Click the + button to expand out ‘'SARADAP’
2) Click 'SARADAP_APPL_NO' to select it.
3) Click the OK button.

(b) Back in the SQL Editor, click the OK button to close the window.
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21. Click the View SQL button and review your finished Report Query. It should look like this:

2 View SQL

and { {

and
and

select SPRIDEN.SPRIDEN ID "Id",
SPRIDEN.SPRIDEN LAST MNAME "LastName",
SPRIDEN.SFPRIDEN FIRST MNAME "FirstName",
SPRADDR.SPRADDE ATYP_CODE "AddrType”,
SPRADDR.SPRADDE_STREET LINE1 "Streetlinel”,
SPRADDR.SFPRADDR_STREET LINEZ "3treetlLinei”,
FFRADDR.SFRADDR_CITY "City",
SPRADDR.SPRADDE_STAT CODE "State”,
SPRADDR.SPRADDE_ZIP "ZipCaode™,
SARADAP.SARADAP_ TERM CODE ENTRY "TermCodeEntry™,
SARADAP.SARADAP LEVL CODE "LevellppCode™,
SARADAP.SARADAP APST CODE "AppStatc”,
SARADAP.JARADAP 3TYP_CODE "3tudTypeCode”,
STVADMT.STVADNT DESC "AdmissType™,
STVAPST.STVAPST DESC,
{select STVLEVL DESC
from 3TVLEVL
where ZARADAP LEVL CODE=3TVLEVL CODE and rownum=1) "LevelDesc™

from SATURN.3PRIDEN SPRIDEN,

SATURN.3FRADDE SPRLIDER,
SATURN.3ARADALP ZSARLDAP,
SATURN.3TVADMT STVLDHT,
SATURN.3TVAPST STVLPST

where ( ZPRIDEN.SPRIDEN PIDM = SARADAP.SARADAP PIDM

and FARADAP.SARADAP ADMT CODE = STVADMT.3TVADMT CCODE
and SARADAP.SARADAP APST CODE = STVAPST.3TVAPST CODE )

SARADAP.SARADAP TERM CODE ENTRY = :mwain DD Term. TermCode

and SPRADDR.SPRADDE_ATYP CODE = :imain DD_AddrType.AddrTypeCode
and { SARADAP.ZARADAP ADMT CCDE = :main LE_AeceptCode. bdmissTypeCode
or :mwain CB_AdwmitType = 'Y' )

and SARADAP.3ARADAFP APPL NO =
{ select Max{ SARADAP1.3ARADAP APPL NO } "ipplyNo"
from ZATURN.ZARADAP SARADAP1
where SARADAP1.SARADAP PIDM = SARADAP.SARADAP PIDM
and SARADAP1.3ARADAP TERM CODE_ENTRY = SARADAF.SARADAP TERM CODE_ENTRY )
spriden change_ ind is null )

spraddr.rowid (+) = £ _get_saddress rowid{3PRIDEN PIDM, 'STDNADDR', 'A', SY¥SDATE, 1,
order hy SPRIDEM.SPRIDEN_ID

)

'S', HULL) } )

Close

22. Commit and test your changes.
NOTE: At this point, your results should no longer include duplicate students.
23. Your first Advanced DataBlock is complete. Click the Close button to exit the DataBlock Designer.

www.evisions.com

rgos Advanced Training - DataBlock Designer Workboo
Document Version 1.0 — Last Updated 2.11.2014

Page 11 of 39



Fifth Exercise: Advanced DataBlock 2 - Budget
Availability

Advanced DataBlock 2 - Budget Availability argos'

powered by ¥ EVISIONS

Chart of Accounts: | B - SCT University

Fund:

Run Dashboard

Fund Orgn Acct Frog TotaladoptBudg TotalBudgadiust TotalYTDACtV TotalEncumb TotalBudgResery | FiscalPeriod

0items

Products Feedback www.evisions.com

Training Support

Exercise Description

In this exercise we are going to copy the DataBlock we created in the second exercise and modify it to make the
‘Run Dashboard’ button’s visibility dependent on the ‘Account’ list box variable. That way, the ‘Run Dashboard’
button will appear only once the end user has chosen a value for all five variables.

Instructions:

Copy the ‘Budget Availability’ DataBlock
24. Find the DataBlock you created in the second exercise, ‘Budget Availability’.
NOTE: If you did not complete Exercise 2, you can request a copy of the DataBlock from the instructor.
25. Right-click on the DataBlock in the Explorer tab, and choose Copy from the menu.
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26.
27.
28.
29.
30.

Click on your user folder to highlight it.

Right-click on your folder, and choose Paste from the menu.

Click the Paste button in the Paste window that appears.

In the Explorer tab, click the name of the new DataBlock and rename it: ‘Advanced Budget Availability’
Click the Edit button to open the DataBlock Designer.

Make the visibility of the ‘Run Dashboard’ button dependent on the ‘Account’ list box

31. Click the 'Run Dashboard’ button to select it.

32. Click the Properties tab:
a. Next to Visible, select ‘main_LB_Acct.AccountCode’

33. Commit and test your changes.
NOTE: Choose a value for the five required variables to make sure the ‘Run Dashboard’ button becomes
visible.

34. Your second Advanced DataBlock is complete. Click the Close button to exit the DataBlock Designer.
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Sixth Exercise: Advanced DataBlock 3 - Student Course

List

Advanced Datablock 3 - Student Course List

Retrieve a student's course list

Select Term: |200940 - Summer 2 2003 v

Enter in Student Last Name OR Student ID Number

Last Name: | |

ID Number: | |

| Get List of Students |

Select the students from the box below before running reports.

1D Murnber | Last Name | First Narme

Products Training Suppert  Feedback

Exercise Description

[#]Include dropped classes in report listing

www.evisions.com

In this exercise we are going to copy the DataBlock we created in the third exercise and modify it so that the ‘Get
List of Students’ button is only enabled once the end user has entered a value in the ‘Last Name’ or ‘ID Number’
text box. You'll add a SQL Variable to control whether the button is enabled or not.

www.evisions.com

rgos Advanced Training - DataBlock Designer Workboo Page 14 of 39

Document Version 1.0 — Last Updated 2.11.2014



Instructions:

Copy the ‘Student Course List’ DataBlock
35. Find the DataBlock you created in the third exercise, Student Course List.
NOTE: If you did not complete Exercise 3, you can request a copy of the DataBlock from the instructor.
36. Right-click on the DataBlock in the Explorer tab, and choose Copy from the menu.
37. Click on your user folder to highlight it.
38. Right-click on your folder, and choose Paste from the menu.
39. Click the Paste button in the Paste window that appears.
40. In the Explorer tab, click the name of the new DataBlock and rename it: ‘Advanced Student Course List’
41. Click the Edit button to open the DataBlock Designer.

Add a SQL variable to set the enable property for the ‘Get List of Students’ button
42. Click the Variables tab.
43. Click the Add Variable button (the green plus sign on the Variable tab toolbar).

Forms | Properties | Yariables

@ 8 x»

a. Inthe Choose Variable Type window, select ‘SQL Statement’ and click the OK button.
Open the Visual Designer:
i. Add Table: 'Dual’
ii. Click the Visible Fields (SELECT) tab:
(1) Click in the Table row and select ‘<calculated>’
(2) Click in the Field row and type: True’
NOTE: Make sure you include the single quotes.
(3) Clickin the As row and type: TrueValue
iii. Click the Conditional Fields (WHERE) tab
(1) Click in the Table row, select ‘<calculated>’
(2) Click in the Field row and click the ellipsis button to open the SQL Editor:
(a) Click the User-Defined Variable button (the ABC button on the toolbar) to bring up a
list of DataBlock variables:
(i) Expand out ‘main_DD_Term’
(i) Click on’ STVTERM_CODE!' to select it.
(iii) Click the OK button.
(b) Back in the SQL Editor window, click the OK button again.
Click in the Condition row and type: is not null

—_— o~
I V)
=z =

In the lower left-hand corner of the tab, click the + button to create a conditional group.

—
u
~

You now have a new conditional group under your root query. Click ‘<group>’ to select it:
(a) Click in the Table row of the new column, and select ‘<calculated>’
(b) Click in the Field row and click the ellipsis button to open the SQL Editor:
(i) Click the User-Defined Variable button (the ABC button on the toolbar) to bring
up a list of DataBlock variables:
1) Click on ‘main_EB_IDNumber’ to select it.
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44,

45.

46.

47.

48.

2) Click the OK button.
(ii) Backin the SQL Editor window, click the OK button again.
Click in the Condition row and type: is not null

2o

Click in the and/or row of the next column, and select ‘or’
e) Click in the Table row of the next column, and select ‘<calculated>’
Click in the Field row and click the ellipsis button to open the SQL Editor:
(i) Click the User-Defined Variable button (the ABC button on the toolbar) to bring
up a list of DataBlock variables:
1) Click on‘main_EB_LastNm' to select it.
2) Click the OK button.
(i) Back in the SQL Editor window, click the OK button again.
(g) Click in the Condition row and type: is not null
iv. Click the OK button to exit the Visual Designer.
c.  Review your SQL query. It should look like this:

—_~ o~ o~ o~
f]

2! SOL Editor: SqlVariable1

select 'True' "TrusValue'™
from 3Y¥3.DULL DUALL
where :main DD Term.3TVTERM CODE is not null
and { :main EE IDNumber is not null
or :main EE Lastlm is not null }

-’:@ Edit Yisual Design  SQL Edit QL Text
Connection: =default> [ Script returns recordset Edit ADD properties

ok || cancel | [ heb

. Click the OK button to and then click the Yes button to validate your new query.
e. Click the OK button, leaving the Test Values blank.
f.  You should see a small window that says:
Results: TrueValue = <null>
g. Click the OK button.
In the Variables tab:
a. Right-click the your new variable, ‘SqlVariable1’, and choose Rename Variable from the menu.
b. Rename your variable by typing: SQL_ButtonEnabled
Click the ‘Get List of Students’ button to select it.
Click the Properties tab:
a. Nextto Enabled, select ‘SQL_ButtonEnabled.TrueValue’
Commit and test your changes.
NOTE: Enter a value for ‘Last Name’ or ID Number’ and then click out of the text box to make sure the ‘Get List
of Students’ button becomes enabled.
Your third Advanced DataBlock is complete. Click the Close button to exit the DataBlock Designer.
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Seventh Exercise: Advanced DataBlock 4 - Registered
Students

Advanced DataBlock 4 - Registered Students al‘gOS'

powersd by

Select Academic Year

Choose the academic year and term type. Analysis will
include the last five years.

Academic Year: | 2009 - @ Fall

) Spring
) Summer

Products Training Support  Feedback Www.evisions.com

Exercise Description

This DataBlock uses a variety of advanced features to allow a Report Viewer to select a data set (in this case,
registered students for a particular year and term type), and see it represented graphically in several different ways
(a variety of charts and an OLAP cube).

The dashboard for this DataBlock will be made up of four separate forms. On the first form (see example image
above), Report Viewers will select an academic year and term type for which they'd like to see data on registered
students. The second form in the dashboard will display a chart that shows the enrollment numbers based on the
user’s selections. From this chart, users will be able to drill down by selecting specific terms to view additional
detail charts with demographic information on registered students for that term. The demographic information is
displayed on a separate form. The last form will display an OLAP (On Line Analytical Processing) cube, which offers
another way to view, interact with, and analyze the requested data set.

Below are examples of what the additional forms in the dashboard will look like:
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Example Chart Form

crat
Advanced DataBlock 4 - Registered Students

Run Registered Student Chart

Registered Students

Click on a year to see a breakdawn of demographic information.

B

199510 199610

Products  Training  Support  Feedback

Example Chart Detail Form

Advanced DataBlock 4 - Registered Students

Demographic Information for Fall 1994

Gender Age

Male 45.31 %
18t0 22 T9E9 %

Over259.38 %

23025938 %
Female 4.6 %

Ethnicity

W Aftican-American
[ Asian Pacific Isiander

W Caucasian

Products  Training  Support  Feedback WWW. evisions.com
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Example OLAP Cube Form

Select Acadenic Vear | Chart | OLAP |
Advanced DataBlock 4 - Registered Students

Run OLAP Cube
[OI#l Available Dimensions
RegReasonCod| v | Effectievel [~ StudTypecode [v| EffectTemcal~| curriMaiorCod{~| Degres [=] colege [~]

= E Columns

Term

%Enml\stat = BE Term [i1] 188510 Fif] 198610 lil  Total by ROWS

Enrollstal Sudent Sludent Sudent
=a T T T
EL o1 58 22
Total by COLUMNS o 58 172

Products  Training  Support  Feedback www.evisions.com

Both the Chart and OLAP forms will automatically display data for the five years leading up to the academic year
selected by the user on the first form. The ‘Term Type' variable allows users to compare several terms of the same
type (i.e. Fall terms from 2005-2010). The dashboard is designed so that the user only needs to make two selections
(year and term type) to retrieve the last five years of data for that term type. Also, the variables restrict the end
user from inadvertently comparing data from different term types. While users may sometimes want to compare
Fall and Spring numbers against each other, that tends to be a rare occasion. It is much more common for users
to want to compare like terms.

Here is a description of the different elements that you'll be creating for this DataBlock, and note on which
database table(s) they draw from:

Academic Year — drop down variable that returns a list of academic years. For example: 2011, 2012, 2013. Table
used: STVTERM

Term Type - radio button variable that returns a list of term types. For example Fall, Winter, Spring. Manually
created list, no table used.

Registered Students — chart that displays a count of registered students grouped by term. This chart will also be
used as a variable for other charts. Table used: SFBETRM

Age Range — chart that displays a count of registered students grouped by age range. Data displayed is based on
a specific term selected in the ‘Registered Students’ chart. Tables used: SFBETRM, SPBPERS

Gender — chart that displays a count of registered students grouped by gender. Data displayed is based on a
specific term selected in the ‘Registered Students’ chart. Tables used: SFBETRM, SPBPERS
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Ethnicity — chart that displays a count of registered students grouped by ethnicity. Data displayed is based on a
specific term selected in the ‘Registered Students’ chart. Tables used: SFBETRM, SPBPERS

Registered Students OLAP Cube — OLAP cube that displays registered student information. Tables used:
SFBETRM, SGBSTDN, STVCOLL

Instructions

Create a new DataBlock and open it for editing

49. Find your user folder in the folder list on the left-hand side.

50. Right-click on your folder, and choose New> DataBlock from the menu.

51. Type in the name of your new DataBlock — ‘Registered Students’ — and hit the Enter key.

52. Click on your new DataBlock to highlight it.

53. On the right side of the screen, under the DataBlock Designer Actions heading, select the ADO being
used for your training from the Associated Connection/Pool drop down.

54. Click the Edit button to open the DataBlock Designer.

Create additional forms

As with all new DataBlocks, when you open this one up for editing, you will see an empty form called ‘Main’.
Because our dashboard for this DataBlock includes more than one form, our first step is to create them. Although
the end user will only navigate between three of them, we're actually going to want to create four forms total
(three primary forms and one that will act as a sub-form).

55. To create a new form, go to the Forms toolbar on the left, and click the Create New Form button (the
form icon with the green plus sign).

Forms | Properties | Yariables

@x@a

NOTE: You should now see a new form in the list called ‘Form1".
56. Click the Create New Form button two more times to create ‘Form2’ and ‘Form3’.
57. Right-click on ‘Form1” and select Rename from the menu.
58. Type ‘Chart’ to rename your form.
59. Repeat steps 60 & 61 to rename ‘Form2’ to ‘ChartA’ and ‘Form3’ to ‘OLAP'.

Configure the form layout

The three main forms the users will be navigating are ‘Main’, ‘Chart’, and ‘OLAP". To make it easy to switch between
them, we're going to create tabs for each of those forms. The form ‘ChartA’ will not be a tab, but the users will link
to it from within the ‘Chart’ form to view additional details on information displayed in the chart.

60. On the Forms tab, click on the ‘Main’ form to select it.
61. On the Properties tab:
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62.

63.

64.
65.

a. Nexttols Tab, select ‘Yes’

b. Next to Tab Name type ‘Select Academic Year’

c.  And while you're here, next to Color, select your background color from the drop down.

Back on the Forms tab, select ‘Chart’. Switch back to Properties, and repeat steps 64a-c., above,
naming the tab ‘Charts’.

Back on the Forms tab again, select ‘OLAP’". Switch back to Properties, and repeat steps 64a-c., naming
the tab ‘OLAP’.

Head back to Form one last time and select ‘ChartA’.

Since this form will not be a tab, simply switch back to Properties, and next to Color, select your
background color from the drop down.

Add template objects to each form

66.
67.

68.
69.

On the Forms tab, click on ‘Main’ to select it.

Click on the Add Objects from Library button to open the Choose an Object window:
a. Your user folder should be automatically selected. (If it's not, click on it to select it.)
b. Click on ‘Training DataBlock Template’ to select it.

c. Click the OK button.

Repeat steps 69 & 70 for ‘Chart’, ‘ChartA’, and ‘OLAP’.

Commit and test your changes.

NOTE: You should see an empty dashboard with 3 tabs.

Add instructions to the ‘Main’ form

70.
71.

72.

73.

74.
75.

On the Forms tab, click on ‘Main’ to select it.
Double-click on the ‘Description/Instructions’ label object and change the text to:
‘Select Academic Year’
Add a new label to the panel, double-click on it, and change the text to:
‘Choose an academic year and term type. Analysis will include the last five years.’
On the Properties tab:
a. Next to Font.Size, type ‘11’
b. Nextto Word Wrap, select ‘Yes’
Click and drag the new subhead to move it under the ‘Select Academic Year’ heading.
Resize to format the text as you see fit.

Add the ‘Academic Year’ variable to the ‘Main’ form

76.

77.

Add a label for the variable
a. Add anew label to the panel.
b. Double-click and change text to ‘Academic Year:
c. Click and drag label to move it beneath the instructions subhead.
Add drop down control object
a. Clickthe Add Drop Down tool.
b. Click on the panel to place the drop down.
c.  Onthe Properties tab:
i. Nextto Variable Name, type ‘main_DD_AcadYr’
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ii. Nextto Auto Select, choose ‘Yes'
d. Click and drag the drop down next to the ‘Select Academic Year:" label.
78. Write a SQL query to supply the list of academic years.
a. Double click on the ‘Academic Year’ drop down.
i. Select’SQL Statement’ then click Next.
ii. Open the Visual Designer.
(1) Add Table: STVTERM
(2) Add'STVTERM_ACYR_CODE' to the Visible Fields (SELECT) tab:
(a) Clickin the As row and type ‘AcadYr'.
(b) Click on the Summing button on the left-hand side of the tab.
(c) In the Summing row, select ‘<Group By>'.
(3) On the Conditional Fields (WHERE) tab:
(@) Add‘STVTERM_CODE’
(b) In the Condition row, type ‘NOT IN ('000000', '999999")
(c) Add’'STVTERM_START_DATE'
(d) In the Condition row, type ‘<=sysdate + 60’
(4) Add‘STVTERM_ACYR_CODE' to the Ordering (ORDER BY) tab:
(@) Inthe Sortrow, select ‘Descending’.
(5) Click the OK button to exit the Visual Designer.
iii. Review your SQL query. It should look like this:

2! Choice Entry

This is the SQL statement that will retrieve the choices For the end-user, Each "SELECT" Field will become a
sub-variable. The associated visual design will nat reflect any changes made here,
Iselel:!t STYTERM.STVTERM ACYR CODE "Acad¥r'
from SATURMN.STVTERM STVTERM
where STVTERM.ZTVTERM CODE HOT IN ('O000000', '935239')
and STVTERM.3ITVTERM START DATE <=sysdate + &0
group by STVTERHM.STVTERM ACYR CODE
order by STVTERH.STVTERM ACYR CODE desc

L&) Edit visual Design SO Edit SGL Text
Connection: <default= [ ] Script returns recordset Edit ADC properties

[ <- Back H Mext - H Finish l[ Cancel

iv. Click the Next button.

v. You should see a list of academic years. Click the Next button.

vi. On the next screen, make sure ‘AcadYr' is selected, and then hit the Finish button.
79. Commit and test your changes.
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Add the ‘Term Type’ radio buttons to the ‘Main’ form
80. Add the radio button control object
a. Click the Add Radio Button Panel button (the image of a radio button on the toolbar).
e B EEEG
b. Click on the panel to place the radio buttons.
c.  Onthe Properties tab:
i. Nextto Variable Name, type ‘main_RB_TermType’
d. Click and drag the radio button panel to the right of the ‘Academic Year’ drop down.
81. Create a list manually to display the term types.
NOTE: Depending on the available term types at your institution the instructor may decide to create the list of
term types manually or may opt to generate the list using a SQL query. The instructions for how to create a
list manually follow.
a. Double click on the ‘TermType’ radio button panel.
i. Leave’Manual Entries’ selected and click the Next button.
ii. You'll want two columns for your manual list—one for the term type code and one for the term
type description. Click the Add Column button on the toolbar to add a new column.

ar Add Column Edit Colurnn

iii. Inthe Column Properties window that pops up:
(1) Click in the Name field, and type ‘Desc'.
(2) Click the OK button.

iv. Click in the first row of the ‘Main’ column.

v. Click the Edit Column button on the toolbar

2R Add Column (1=] Edit Calumn

to open the Column Properties window:

(1) Click in the Name field, and type ‘Code’".

(2) Click the OK button.
NOTE: Your list now has two columns, one named ‘Code’ and one named ‘Desc’. The ‘Code’ column will
be a list of term type codes, i.e., 10, 20, 30. The ‘Desc’ column will have the corresponding term type
descriptions, i.e. Fall, Spring, Summer.
vi. In the first row of the ‘Code’ column, type the code for your school’s first term type (e.g.,'10).
vii. Click in the first row of the ‘Desc’ column and type the description for that term type (e.g., ‘Fall’).
viii. Click the Add Row button (the green plus on the left side of the window)

|Cu:u:|e |Desc |
1o Fall

®

to add a new row to your list.
ix. Repeat steps vi.-viii. until you have added codes and descriptions for all of your institution’s
term types.
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82.

NOTE: You can rearrange the order of the term types by selecting a row, and clicking the blue up and
down arrows to the left.
X.  When your list is complete, click the Next button.
xi. Select’Desc’ to display the descriptions (not the term codes) to the users.
xii. Click the Finish button.
Commit and test your changes.

Add instructions, a run button, and the ‘Registered Student’ chart to the ‘Chart’ form

83.
84.

85.

86.

87.
88.
89.
90.

91.
92.
93.

94.
95.
96.

97.

On the Forms tab, click on ‘Chart’ to select it.

Double-click on the ‘Description/Instructions’ label object and change the text to:
‘Registered Students’

Add a new label to the panel, double-click on it, and change the text to:
‘Click on a year to see a breakdown of demographic information.’

On the Properties tab:

a. Nextto Font.Size, type ‘11’

b. Nextto Word Wrap, select ‘Yes’

Click and drag the new subhead to move it under the ‘Registered Students’ heading.

Click and drag to resize, as you see fit.

Click Add Button (the OK button on the toolbar) and click to add it to the panel.

On the Properties tab:

a. Next to Text type ‘Run Registered Student Chart’

b. Nextto Variable Name, type ‘chart_BT_RunChart’

Resize the button until the full text is visible.

Click and drag the button to the upper part of the panel.

Click on the Add Chart button (the pie chart icon on the toolbar)

L] J .I_IJi I:él:é @

to add a new chart.

Click on the panel to place the chart.

Resize the chart so that it almost fills the panel.

On the Properties tab:

a. Next to Variable Name, type ‘chart_CT_RegStdnts’

Double click on the ‘Registered Students’ chart, to open the Chart Wizard window:
a. Onthe welcome screen, click the Next button.

b. Click the Add Series button (the green plus sign on the Series Manager toolbar)

@
to add a new series.
NOTE: A series is a set of data points that are displayed in a chart. Charts can have multiple series, but in
this example we are displaying only one set of data.
c.  On the Data tab:
i. Next to Series Name, type 'RegStudents’.
d. To theright of the Dataset drop down, click the hard haticon.
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i. Inthe Dataset Name window that pops up, type ‘chart_SQL_RegStdnts’ and click the OK
button.
ii. Select’SQL Statement’ and click the OK button.
iii. Open the Visual Designer:
(1) Add table: 'SFBETRM'
(2) On the Visible Fields (SELECT) tab:
(a) Add fields: 'SFBETRM_PIDM’ and ‘SFBETRM_TERM_CODE’
(b) Click the Summing button.
() Inthe Summing row for ‘SFBETRM_PIDM' select ‘Count’.
(d) Inthe Summing row for 'SFBETRM_TERM_CODE' select ‘<Group By>".
(3) On the Conditional Fields (WHERE) tab:
(@) Clickin the Table row of the first column and select ‘<calculated>'.
(b) Double-click in the Field row to open the SQL Editor:
(i) Click the User-Defined Variable button (the ABC button):
1) Click on‘chart_BT_RunChart’ to select it.
2) Click the OK button.
(i) Click the OK button.
(c) Click in the Condition row and type ‘is not null'.
(4) In the next column:
(a) Click in the Table row and select ‘<calculated>'.
(b) Double-click in the Field row to open the SQL Editor:
(i) Type‘f_registered_this_term(’
(i) Click the Insert a field button (the green neutron)
(ii) Click the plus sign to expand SFBETRM
(iv) Select SFBETRM_PIDM, click OK
(v) Type'/
(vi) Click the Insert a field button (the green neutron)
(vii) Click the plus sign to expand SFBETRM
(viii)Select SFBETRM_TERM_CODE, click OK
(ix) Type')'
(x) Click OK to exit the SQL Editor
(c) Click in the Condition row and type ‘="Y"’ (include single quotes around Y)
(d) Repeat steps (a-c) to create the following conditions

Table Field Condition

<calculated> | substr(SFBETRM.SFBETRM_TERM_CODE,1,4) between :main_DD_AcadYr.AcadYr -5 and
:main_DD_AcadYr.AcadYr

<calculated> | substr(SFBETRM.SFBETRM_TERM_CODE,5,2) =:main_RB_TermType.Code

(5) On the Ordering (ORDER BY) tab:

(a) Add field: 'SFBETRM_TERM_CODE'

(b) In the Sort row, make sure ‘Ascending’ is selected.
(6) Click the OK button.
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iv. Review your SQL query. It should look like this:

2 S0L Editor: chart_SOL_RegStdnts

select Count{ SFEETREM.SFEETRM PIDM )} "InternalId"”,

SFEETRM.SFEETEM TERM CCDE "Term"
from 3ATURN.3SFEETEM SFEETEHM

where :chart BT RunChart is not null
and F_registered this term{SFEETEM.SFEETEM PIDM, SFEBETRM.SFBETRM TERM COLDE) ='¥'
and substr{3FEETRM.SFEETRM TERM CODE,1,4) between :main DD Acad¥r.Acad¥r -5 and :main DD Acad¥r.Acad¥r
and substr(3FEETRM.SFEETRM TERM CODE,5,2) =:main RE TermType.Code

group by SFEETRM.SFEETRM TERM CODE

order by SFEETRM.SFEETEM TERM CCDE

":@ Edit Visual Design QL Edit SQL Text
Connection: <default= [ Script returns recordset Edit ADO properties

’ [o]4 H Cancel l ’ Help

v. Click the OK button to exit the Visual Designer and then click the Yes button to validate your
new query.
vi. Click the OK button, leaving the Test Values blank.

vii. You should see a small window that says:
Results:
InternallD = (null)
Term = (null)
viii. Click the OK button.
Back on the Data tab:
i. From the Value drop down, select ‘InternallD’.
ii. From Label drop down, select ‘Term’
Click the Next button.
The Chart Theme and Panel screen has a wide variety of formatting options to choose from. You
can select a predefined Theme from the Apply a Theme list box, or a color palette from the Select
a Palette list box. Below, you can modify the background on the Format Background Panel tab.
Try out a few options, until you find one you like, and click the Next button.
On the Legend Style and Position tab:
i. Click the ‘Legend Visible’ checkbox to uncheck it.
Click the Finish button.

98. Commit and test your changes.

Add the ‘Ethnicity’ chart to the ‘ChartA’ form

From the ‘Registered Students’ chart we just created, users will be able to click on a term to see detailed
demographic data for registered students in that term. The ‘ChartA’ form we created will house these detail
charts, sometimes referred to as drill downs. Our next step will be to create the ‘Ethnicity’ drill down chart,
which will display the ethnicity breakdown of all registered students for the selected term.
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When creating drill down charts like this, you must recreate all of the same constraints you used in the main
chart so that the drill downs are displaying information from the same data set. In this case, because the
‘Registered Students’ chart counts only registered students, the ‘Ethnicity’ chart must have the same
constraints. The easiest way to ensure the constraints match exactly is to copy the SQL from the ‘Registered
Students’ chart and simply modify it for the ‘Ethnicity’ chart (and any other drill downs).

99. Copy the SQL from the ‘Registered Students’ chart.
a. Onthe Variables tab:
i. Click ‘Chart_SQL_RegStdnts’ to select the SQL for the ‘Registered Students’ chart.
ii. Right-click and select Copy from the menu.
iii. Right-click anywhere on the Variables tab and select Paste from the menu.
iv. Right-click on the new variable, called ‘SglVariable1’, and rename it to ‘ChartA_SQL_Ethnicity’.
100. Modify the ‘Ethnicity’ SQL to display ethnicity for registered students in a selected term.
a. Double-click on ‘ChartA_SQL_Ethnicity’ and open the Visual Designer:
i. Add tables: ‘SPBPERS’ and ‘STVETHN'
ii. Create table joins:
(1) Inthe ‘SFBETRM' table window, click on ‘SFBETRM_PIDM’ (row 2), drag it to the ‘SPBPERS’
table window, and drop it on ‘'SPBPERS_PIDM’ (row 1).
(2) Inthe ‘SPBPERS’ table window, click on ‘SPBPERS_ETHN_CODE’ (row 5), drag it to the
‘STVETHN' table window, and drop it on ‘STVETHN_CODE’ (row 1).
iii. On the Visible Fields (SELECT) tab:
(1) Delete 'SFBETRM_TERM_CODE' by clicking the X button at the top of the column.
(2) Add field:'STVETHN_DESC'.
(3) Make sure the Summing row still shows ‘<Group By>'.
iv. On the Conditional Fields (WHERE) tab:
(1) Delete the first, third, and fourth conditions by clicking the X button at the top of their
columns.
NOTE: This means that only the follow condition should remain:
‘F_registered_this_term(SFBETRM.SFBETRM_PIDM,SFBETRM.SFBETRM_TERM_CODE) =Y’
(2) Add ‘SFBETRM_TERM_CODE' from the ‘SFBETRM’ table window.
(3) Double-click in the Condition row to open the SQL Editor:
(a) Click the Add User-Defined Variable button (the ABC button):
(i) Expand out ‘Chart_CT_RegStudents'.
(ii) Beneath that, expand out the ‘RegStudents’ series.
(iii) Click on ‘Term’ to select it.
(iv) Click the OK button.
(b) Click the OK button.
v. Onthe Ordering (ORDER BY) tab:
(1) Delete 'SFBETRM_TERM_CODE' by clicking the X button at the top of the column.
(2) Add’'STVETHN_DESC' from the ‘STVETHN' table window.
vi. Click the OK button.
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vii. Review your SQL query. It should look like this:

select Count({ SFBETRM.IFEETREM FIDM } "Internalld"™,
STVETHN.STVETHN DESC "EthinieGroup'
from ZFATURN.3IFEETEM SFEETERM,
ZATURN.3PEFPERS SFEPERS,
SATURN.3TVETHN STVETHN
where { SFEETEM.SFEETRM PIDM = ZPEPERS.SPEPERS PIDHM
and SPEPERS.ZFPEPERS ETHN CODE = STVETHN.STVETHW CODE })
and { F registered this term({3FEETEM.SFEETREM PIDHN,SFEETRM.3FEETEM TEEM CODE) ='TY!'
and SFEETREM.SFEETEM TEEM CODE = :chart CT Reg3tudents.Regitudents.Term })
group by STVETHN.STVETHN DESC
order by STVETHN.STVETHN DE3C

L) Edit visual Design S Edit SOL Text

Connection: <defaulk> [ Scripk reburns recordset Edit ADO propetties

Ok, l [ Cancel ] [ Help

viii. Click the OK button to and then click the Yes button to validate your new query.
ix. Click the OK button, leaving the test values blank.
X.  You should see a small window that says:
Results:
InternallD = (null)
Term = (null)
i. Click the OK button.

101.Create the ‘Ethnicity’ chart

a

® o N T

On the Forms tab:

i. Click ‘ChartA’ to selectit.

Click on the Add Chart button (the pie chart icon on the toolbar) to add a new chart.

Click on the panel to place the chart.

Click and drag it to the bottom of the panel.

Resize the chart so it takes up the full width and most of the lower half of the form.

NOTE: You'll need to leave room for the other two charts you’ll be adding to this form. See the example

images at the beginning of this exercise for reference.

On the Properties tab:

i. Nextto Variable Name, type ‘ChartA_CT_Ethnicity'.

Double click on the ‘Ethnicity’ chart, to open the Chart Wizard window:

i.  On the welcome screen, click the Next button.

ii. Click the Add Series button (the green plus sign on the Series Manager toolbar) to add a new
series.

iii. On the Data tab:
(1) Next to Series Name, type ‘Ethnicity’.
(2) From the Dataset drop down, select the variable we just created: ‘ChartA_SQL_Ethnicity’.
(3) From the Value drop down, select ‘InternallD’.
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(4) From the Label drop down, select ‘EthnicGroup’.
iv. Click the Next button.
v. On the Chart Theme and Panel screen, select a theme and color palette for your chart.
vi. Click the Next button, which will take you to the Chart Legends and Titles screen.
vii. Click on‘Main Title’ in the list to select it.
viii. On the Title tab:
(1) Type ‘Ethnicity’ in the Enter Title Here text box.
(2) From the Alignment drop down, select ‘Center’.
(3) Click the Font button or the Format tab to adjust the title formatting as desired.
ix. Click the Advanced button in the lower left corner
(1) Click Yes to continue
(2) Inthe editing box, click on the arrow next to Axis to expand the selection
(3) Select Bottom Axis
(4) Uncheck the Visible box
x. Click the Close button.
h. Click Commit, but don't bother testing your changes yet. We have created a new chart but we
haven't yet added a way to navigate to that chart.

Create navigation from the ‘Chart’ form to the ‘ChartA’ form
102.0n the Form tab:
a. Click on ‘Chart’ to select it.
103.0n the panel, click on the ‘Registered Students’ chart to select it.
104.0n the Properties tab:
a. Next to Cursor, select ‘'HandPoint'.
NOTE: This will make the cursor turn into a pointing hand when it’s over the ‘Registered Students’ chart,
which will indicate to the end user that clicking on the chart does something.
b. Nextto On Click, click the ellipsis button to open the Edit Event window:
i. From the Available Events list, select ‘Activate Form'.
ii. Click the blue arrow button to move ‘Activate Form’ to the Event List.
iii. Inthe Event List, click ‘Activate Form’ to select it.
iv. From the Event Properties drop down, select ‘ChartA'’.
v. Click the OK button.
105.Commit and test your changes.
NOTE: To test that your On Click navigation works, you'll need to select an academic year from the drop
down, go to the ‘Chart’ tab, run the ‘Registered Student’ chart and then click the bar of the term for which you
want to see details. It should take you to the ‘ChartA’ form. Click the ‘Charts’ tab to get back to the ‘Registered
Student’ chart.

Add the ‘Gender’ chart to the ‘ChartA’ form
Much like we did with the ‘Ethnicity’ chart, we're going to copy the SQL variable from ‘Ethnicity’ and use it as

our base for the ‘Gender’ chart, which will also live on the ‘ChartA’ form.

106.Copy the SQL from the ‘Ethnicity’ chart.
a.  Onthe Variables tab:

www.evisions.com rgos Advanced Training - DataBlock Designer Workboo Page 29 of 39
Document Version 1.0 — Last Updated 2.11.2014



i. Click ‘ChartA_SQL_Ethnicity’ to select it.
ii. Right-click and select Copy from the menu.
iii. Right-click anywhere on the Variables tab and select Paste from the menu.
iv. Right-click on the new variable, called ‘SqlVariable1’, and rename it to ‘ChartA_SQL_Gender'.
107.Modify the ‘Gender’ SQL to display gender for registered students in a selected term.
a. Double-click on ‘ChartA_SQL_Gender’ and open the Visual Designer:
i. Remove the 'STVETHN' table.
ii. On the Visible Fields (SELECT) tab:
(1) Click in the Table row of the second column and select ‘<calculated>".
(2) Double-click in the Field row to open the SQL Editor:
(a) Type the following to create a case statement to display the gender values:
case
when SPBPERS.SPBPERS_SEX = 'F' then 'Female'
when SPBPERS.SPBPERS_SEX = 'M' then 'Male'
else 'Unknown'
end
NOTE: You can use the Insert Field button (green neutron on the toolbar) to find the
‘'SPBPERS.SPBPERS_SEX field.
(b) Click the OK button.
(3) Inthe As row, type ‘Gender’.
(4) Confirm that the Summing row is set to ‘<Group By>'.
iii. We don't need to make any changes to the Conditional Fields (WHERE) or Ordering (ORDER
BY) tabs, so click the OK button to close the Visual Designer.
b. Review your SQL query. It should look like this:

3. 5QL Editor: chartA_SOl_Gender

select Count{ SFEETEM.3FEETRM PIDM } "Internalld"”,
case
when SPEPERS.SPEPERS SEX 'F' then 'Female'
when SPEPERS.3PEPER3 2EX = 'N' then 'Hale!
else 'Unknouwn'
End "Gender™
from SALATURN.SFEETEM SFEETERM,
SATURN. SPEFPERS SFPEBFPERS
where { SFEETRM.SFEETEM PIDM = SPEPERS.SPEPERZ PIDHM )
and { F registered this term{3FBEETEM.3FEETRM PIDM, SFEETRM.SFEETEM TERM CODE)} ='¥'
and SFEETRM.3FEETRM TERM CODE = :chart CT Reg3tudents.PReg3tudents.Term }
group by case
when SPEPERS.SPEFERS SEX = 'F' then 'Female'

when SPEPERS.SPEFERS SEX = 'H' then 'Hale!
else 'TUnknown'
End

J8) Edit visual Design SO Edit SOL Text

Conmeckion: <defaulk> [ Script returns recordset Edit ADO properties
04 ] [ Cancel I [ Help
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f.

Click the OK button to and then click the Yes button to validate your new query.
Click the OK button, leaving the test values blank.

You should see a small window that says:

Results:

InternallD = (null)

Gender = (null)

Click the OK button.

108.Create the ‘Gender’ chart.

a.

Qo N T

On the Forms tab:
i. Click ‘ChartA’ to selectit.
Click on the Add Chart button (the pie chart icon on the toolbar) to add a new chart.
Click on the panel to place the chart.
Click and drag it to the upper left corner of the panel.
Resize the chart so it takes up roughly a quarter of the panel.
NOTE: Remember to leave room for one more chart.
On the Properties tab:
i. Nextto Variable Name, type ‘ChartA_CT_Gender’
Double click on the ‘Gender’ chart, to open the Chart Wizard window:
i.  Onthe welcome screen, click the Next button.
ii. Click the Add Series button (the green plus sign on the Series Manager toolbar) to add a new
series.
iii. On the Data tab:
(1) Next to Series Name, type ‘Gender’.
(2) From the Dataset drop down, select the ‘ChartA_SQL_Gender’ variable.
(3) From the Value drop down, select ‘Internal ID'.
(4) From the Label drop down, select ‘Gender’.
iv. On the Type tab:
(1) Under Select Chart Type, select ‘Pie Chart'.
v. On the Labels tab:
(1) From the Label Style drop down, select ‘Value'.
vi. Click the Next button.
vii. On the Chart Theme and Panel screen, select a theme and color palette for your chart.
viii. Click the Next button, which will take you to the Chart Legends and Titles screen.
ix. On the Legend Style and Title tab:
(1) Uncheck the Legend Visible checkbox
X. Click on ‘Main Title’ in the list to select it.
xi. On the Title tab:
(1) Type ‘Gender’ in the Enter Title Here text box.
(2) From the Alignment drop down, select ‘Center’.
(3) Click the Font button or the Format tab to adjust the title formatting as desired.
xii. Click the Finish button.

109.Commit and test your changes.
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Add the ‘Age Range’ chart to the ‘ChartA’ form

The ‘Age Range’ chart will be the last chart on the ‘ChartA’ form. We'll put it together in much the same way,
starting with the ‘Gender’ chart SQL variable.

110.Copy the SQL from the ‘Gender’ chart.
a. Onthe Variables tab:
i. Click ‘ChartA_SQL_Gender’ to select it.
ii. Right-click and select Copy from the menu.
iii. Right-click anywhere on the Variables tab and select Paste from the menu.
iv. Right-click on the new variable, called ‘SqlVariable1’, and rename it to ‘ChartA_SQL_Age’.
111.Modify the ‘Age Range’ SQL to display the age ranges for registered students in a selected term.
a. Double-click on ‘ChartA_SQL_Age’ and open the Visual Designer:
i.  On the Visible Fields (SELECT) tab:
(1) Delete the case statement from the second column by clicking the red X button at the top.
(2) Click in the Table row of the second column and select ‘<calculated>"'.
(3) Double-click in the Field row to open the SQL Editor:
(@) Type the following to create a case statement to display age groups:

case
when SPBPERS.SPBPERS_BIRTH_DATE is null then 'Unknown'
when (substr (SFBETRM.SFBETRM_TERM_CODE, 1, 4)) - (to_char
(SPBPERS.SPBPERS_BIRTH_DATE, 'YYYY'))< 18 then 'Under 18'
when (substr (SFBETRM.SFBETRM_TERM_CODE, 1, 4)) - (to_char
(SPBPERS.SPBPERS_BIRTH_DATE, 'YYYY")) < 23 then '18 to 22"
when (substr (SFBETRM.SFBETRM_TERM_CODE, 1, 4)) - (to_char
(SPBPERS.SPBPERS_BIRTH_DATE, 'YYYY")) < 26 then '23 to 25'
else 'Over 25'
End
NOTE: Again, remember to use the Insert Field button. Copying and pasting will speed this up
too—the 3 ‘when’lines are very similar and can be easily copied and edited for each age group.
(b) Click the OK button.
In the As row, type ‘AgeGroup’.
Confirm that the Summing row is set to ‘<Group By>'.

N

—_~ o~~~
O
=2 L2

Click in the Table row of the third column, and select ‘<calculated>'.

~N

Right-click the Field row of the second column and choose Copy from the menu to copy

the case statement you just wrote.

Right-click in the Field row of the third column and choose Paste from the menu.

(9) Double-click in the Field row of the third column to open the SQL Editor:

(a) Edit the case statement as follows—replacing the age group descriptions with the
numbers 1-5—to create an order by which the ‘Age Range’ chart will sort the data:
case

®

when SPBPERS.SPBPERS_BIRTH_DATE is null then 1
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when (substr (SFBETRM.SFBETRM_TERM_CODE, 1, 4)) - (to_char
(SPBPERS.SPBPERS_BIRTH_DATE, 'YYYY")< 18 then 2

when (substr (SFBETRM.SFBETRM_TERM_CODE, 1, 4)) - (to_char
(SPBPERS.SPBPERS_BIRTH_DATE, 'YYYY'")) < 23 then 3

when (substr (SFBETRM.SFBETRM_TERM_CODE, 1, 4)) - (to_char
(SPBPERS.SPBPERS_BIRTH_DATE, 'YYYY") < 26 then 4

else5
End
(b) Click the OK button.
(10) In the As row, type 'SortMe'.

(11) Confirm that the Summing row is set to ‘<Group By>"'.

ii. Onthe Ordering (ORDER BY) tab:

(1) Inthe Table row, select ‘<calculated>"'.

(2) Inthe Field row, type ‘3'.

iii. Click the OK button to close the Visual Designer.
b. Review your SQL query. It should look like this:

3! SOL Editor: charthA_SOL_Age

case

elze 'Over 25'
End "Age Group",

select Count{ SFEETRN.SFEETRM PIDM } "Internalld",

when SPEPERS.SPEPERS_EBIRTH DATE is null then 'Unknown'
when {substr (SFEETRM.SFEETRM TERM CODE, 1, 4}} - {(to char (SPEPERS.SPEPER3_BIRTH DATE,
when {substr (SFEETRM.SFEETRM TERM CODE, 1, 4}} - {(to char (SPEPERS.SPEPER3_BIRTH DATE,
when {substr (SFEETRM.SFEETRM TERM CODE, 1, 4}} - {(to char (SPEPERS.SPEPER3_BIRTH DATE,

VYT ) )<
VYY) )<
VYY) )<

18 then 'Under 185'
23 then '18-22'
Zz6 then '23-25'

case
when SPEPERS.SPEPERS_BIRTH DATE is null then 1
when (substr (SFEETEM.SFEETEM TERM CODE, 1, 4)) - (to char (SPEPERS.SPBPER3 BIRTH DATE, 'YYYY'))< 18 then 2
when (substr (SFEETEM.3IFEETREM TERM CODE, 1, 4)) - (to char (3PEPER3I.SPBPERI EIRTH DATE, 'YYTY'))< 23 then 2
when (substr (SFEETEM.3IFEETREM TERM CODE, 1, 4)) - (to char (3PEPER3I.SPBPERI EIRTH DATE, 'YYTY'))< Z6 then 2
else 5
End "Sort He"
from SATURM.SFEETRM IFEETRM,
SATURM. SPEPERS SPEPERS
where { SFEETRM.SFEETEM PIDM = SPEPERS.SPEPERS_PIDHN )
and { F_registered this term{3FEETRM.SFEETRM PIDM,SFEETRM.3FEETRM_TERM CODE) ='TY'
and SFEETRM.SFEETRM TEREM CODE = :chart CT Regitudents.Regitudents.Term )
group by case
when SPEPER3.SPEPERI_EIRTH DATE is null then 'Unknown'
when (substr (SFEETRN.SFEETEM TERM CODE, 1, 4)) - (to_char (SPEPER3.3SPEFER3_BIRTH DATE, 'YYYY¥'))< 18 then 'Under 1&'
when (substr (SFEETRM.SFEETEM TERM CODE, 1, 4)) - (to char (SPEPERS.SPEPER3S_BIRTH DATE, 'YYY¥'))< 23 then '18-22!
when (substr (SFEETRN.3IFEETEM TERM CODE, 1, 4)) - (to char (SPEPERZ.3SPEPER3_EBIRTH DATE, 'YYYY¥'))< 26 then 'Z3-Z5!
else 'Owver 25'
End,
case
when SPEFPERS.SPEPERI_BIRTH DATE is null then 1
when (substr (SFEETRM.SFEETEM TERM CODE, 1, 4)} - {to char (3PEPERS.SPEPERS_EBIRTH DATE, 'Y¥YY')}< 15 then 2
when (substr (SFEETRM.SFEETEM TERM CODE, 1, 4}) - {(to char (3PEPERZ.SPEPERS_EBIRTH DATE, 'Y¥YY'))< 23 then 2
when (substr (SFEETRM.SFEETREM TERM CODE, 1, 43} - {(to char (3PEPER3.3PEPER3_EIRTH DATE, 'YYYY'))< 26 then 2
else 5
End
order by 3
-{f@ Edit Wisual Design SO Edit SQL Text
Connection: <default> [ ] Script returns recordset Edit ADO properties
[ O H Cancel ] [ Help
c. Click the OK button to and then click the Yes button to validate your new query.
d. Click the OK button, leaving the test values blank.
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f.

a.

~o a0 T

You should see a small window that says:

Results:

InternallD = (null)
AgeGroup = (null)
SortMe = (null)

Click the OK button.
112.Create the ‘Age Range’ chart.
On the Forms tab:

Click ‘ChartA’ to select it.

Click on the Add Chart button (the pie chart icon on the toolbar) to add a new chart.
Click on the panel to place the chart.

Click and drag it to the upper right corner of the panel.

Resize the chart so it takes up the remaining quarter of the panel.

On the Properties tab:

Next to Variable Name, type ‘ChartA_CT_Age’

Double click on the ‘Age Range’ chart, to open the Chart Wizard window:

Vi.
vii.

viii.

Xi.

Xii.

On the welcome screen, click the Next button.

Click the Add Series button (the green plus sign on the Series Manager toolbar) to add a new
series.

On the Data tab:

(1) Next to Series Name, type ‘Age’.

(2) From the Dataset drop down, select the ‘ChartA_SQL_Age’ variable.

(3) From the Value drop down, select ‘Internal ID'.

(4) From the Label drop down, select ‘AgeGroup’.

On the Type tab:

(1) Under Select Chart Type, select ‘Pie Chart'.

On the Labels tab:

(1) From the Label Style drop down, select ‘Percent’.

Click the Next button.

On the Chart Theme and Panel screen, select a theme and color palette for your chart.
Click the Next button, which will take you to the Chart Legends and Titles screen.
On the Legend Style and Title tab:

(1) Uncheck the Legend Visible checkbox

Click on ‘Main Title" in the list to select it.

On the Title tab:

(1) Type ‘Age Range’ in the Enter Title Here text box.

(2) From the Alignment drop down, select ‘Center’.

(3) Click the Font button or the Format tab to adjust the title formatting as desired.
Click the Finish button.

113.Commit and test your changes.

Add a run button and an OLAP cube to the ‘OLAP’ form
114.Create run button for the OLAP cube.
On the Forms tab, click on ‘OLAP’ to select it.

a.
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b. Click Add Button (the OK button on the toolbar) and click to add it to the panel.
On the Properties tab:
i.  Next to Text type ‘Run OLAP Cube’
ii. Nextto Variable Name, type ‘OLAP_BT_RunOLAP’
d. Resize the button until the full text is visible.
e. Click and drag the button to the upper right corner of the panel.
115.Copy the SQL from the ‘Registered Students’ chart.
NOTE: Unlike for the other charts in this exercise, we can’t just duplicate the SQL variable and modify it.
Instead, we're going to go into the Visual Designer, copy the SQL directly, and paste it into an OLAP object.
a. Onthe Variables tab:
i. Double-click ‘Chart_SQL_RegStdnts’, and open the Visual Designer:
(1) Click the Copy button on the toolbar.
(2) Click the Close button to exit the Visual Designer.
ii. Click the Close button again.
116.Click the Add OLAP Cube button (the cube icon on the toolbar)

to add a new OLAP object.
117.Click on the panel to place the cube.
NOTE: For most DataBlock elements, we would assign a variable name at this point. However, since OLAP
cubes cannot be referenced as variables by other SQL queries, we don’t need to assign them a variable name.
118.Resize the OLAP cube so that it fills the entire panel.
119.Double-click on the cube to open the Build OLAP Data Cube window:
a.  On the Main Properties screen, leave everything in its default setting, and hit the Next button.
b. On the Build Statements screen, click the hard hat icon at the bottom to open the Visual Designer:
i. Click the Paste button in the toolbar to paste in the SQL from the ‘Registered Students’ chart.
ii. Add table:'SGBSTDN’
iii. Create atable join:
(1) Inthe ‘SFBETRM' table window, click on ‘SFBETRM_PIDM'’ (row 2), drag it to the 'SGBSTDN’
table window, and drop it on ‘SGBSTDN_PIDM’ (row 1).
(2) Right-click on the join and select Edit Join from the menu.
(3) In the Edit Join window, select ‘Outer Left Join'.
NOTE: Make sure that 'SFBETRM’ is the left table and 'SGBSTDN' is the right table.
(4) Click the OK button.
iv. On the Visible Fields (SELECT) tab:
(1) Delete both fields by clicking the X button at the top of the columns.
(2) Click the Summing button to turn summing off.
(3) Add the following fields:
SFBETRM.SFBETRM_PIDM
SFBETRM.SFBETRM_TERM_CODE
SFBETRM.SFBETRM_ESTS_CODE
SFBETRM.SFBETRM_RGRE_CODE
SGBSTDN.SGBSTDN_LEVL_CODE
SGBSTDN.SGBSTDN_STYP_CODE
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V.

Vi.

SGBSTDN.SGBSTDN_COLL_CODE_1
SGBSTDN.SGBSTDN_MAJR_CODE_1
NOTE: With the exception of SFBETRM_PIDM, these will be the dimensions for your OLAP cube.
(4) Click in the Table row of the next column and select ‘<calculated>'.
(5) Double-click in the Field row to open the SQL Editor:
(@) Type the following to create a scalar sub query that will include the degree
descriptions in the OLAP cube:

(select stvdegc_desc
from stvdegc
where sgbstdn_degc_code_1 = stvdegc_code

and rownum = 1)

(b) Click the OK button.
(c) Inthe As row, type ‘Degree’.
(d) Click the Table row of the next column and select ‘<calculated>'.
(e) Double-click in the Field row to open the SQL Editor:
(i) Type the following, a Banner function, to retrieve the college description:

f_get_desc_fnc('STVCOLL',SGBSTDN.SGBSTDN_COLL_CODE_1,30)

(f) Inthe As row, type ‘College’.
On the Conditional Fields (WHERE) tab:
(1) Find the condition that points to the Chart button.
NOTE: This should be the first condition. The Field row will read “Chart_BT_RunChart'.
(2) Double-click in the Field row to open the SQL Editor:
(@) Click the Add User-Defined Variable button (the ABC button):
(i) Click on ‘OLAP_BT_RunOLAP’ to select it
(i) Click the OK button.
(b) Click the OK button
On the Ordering (ORDER BY) tab:
(1) Delete 'SFBETRM_TERM_CODE' by clicking the X button at the top of the column.
NOTE: The OLAP cube will order the data automatically.

vii. The last step is to add a correlated sub query to evaluate for the latest term. Click the Sub

Query button on the toolbar to open a new visual design window:
(1) Add table: 'SGBSTDN’

NOTE: The table is automatically added under the alias 'SGBSTDN1".
(2) On the Visible Fields (SELECT) tab:

(a) Add field: 'SGBSTDN_TERM_CODE_EFF’

(b) Click the Summing button.

(¢) Inthe Summing row, select ‘Max'.
(3) On the Conditional Fields (WHERE) tab:

(a) Add field: 'SGBSTDN_PIDM’

(b) Double-click in the Condition row to open the SQL Editor:
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(i) Click the Insert Field button (green neutron on the toolbar):
1) Expand out ‘SGBSTDN'.
NOTE: Make sure you select 'SGBSTDN’ and NOT ‘SGBSTDNT".
2) Click on ‘'SGBSTDN_PIDM' to select it.
3) Click the OK button.
(i) Click the OK button.
(4) Click the View SQL button on the toolbar, and review your sub-query. It should look like
this:

2 View SOL |zl@@

select Max{ ZGESTDM1.3GEITDN TERM CoODE EFF ) "EffectTerm3ItudBec™
from JATURIN.SGEITDN 3IGEITDNL
where SGESTDN1.3GESTDN PIDM = SGESTDN.SGESTDN _PIDHM

Close

(a) Click the Close button.
(5) Click the OK button to return to your original visual design window.

viii. You'll see that you have a new box—called ‘Query’—in your visual design.

NOTE: Remember, if you want to rename the ‘Query’ box, click on the Edit Query Properties button
(the hardhat and hammer) on the ‘Query’ box toolbar.

ix. Click the Add to Conditional Fields Tree button in the ‘Query’ box (the window icon with the
green plus on the ‘Query) to add your correlated subquery to the Conditional Fields (WHERE)
tab.

X. On the Conditional Fields (WHERE) tab:

(1) In the conditional fields tree on the left, you'll see a new condition called ‘<query>". Click to
selectit.
(2) Click the radio button for ‘=", which will display a new column of information about your
new condition.
(3) Double-click in the Field row to open the SQL Editor:
(@) Click the Insert Field button (the green neutron on the toolbar):
(i) Expand out 'SGBSTDN'.
(i) Click on 'SGBSTDN_TERM_CODE_EFF’ to select it.
(iii) Click the OK button.
(b) Click the OK button.
NOTE: Depending on your Banner configuration of the 'SGBSTDN' table, your instructor may add in
additional conditions.
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xi. Click the View SQL button on the toolbar, and review your sub-query. It should look like this:

2 View SOL

select SFEETRM.SFBETEM PIDM "InternalId"”,
SFEETRM.3FBEETEM TERM CODE "Term",
SFEETRM.3FBETREM ESTS_CODE "EnrollS3tatc™,
SFEETRM.SFEETRM RGRE CODE "RegReasonCode”,
SGESTDN.3GESTDN_LEVL CODE "EffectlLevel™,
SGEITDN.3GESTDN_STYP_CODE "StudTypecCode™,
SGEITDN.3GESTDN_COLL_CODE_1 "EffectTermColll™,
SGESTDN.3GESTDN_MAJE_CODE_1 "CurriMajorCode”,
(select 3TVDEGC DESC
from STVDEGC
where STVDEGC CODE = SGESTDMN_DEGC _CODE_1
and rownum =1) "Degree",
f_get_desc_fnc('3TVCOLL' ,3GESTDN.3GESTDN_COLL_CCDE_1,30) "College"
from 3ATURN.ZFEETREM SFEETEM,
SATURN. 3GESTDN 3IGEITDN
where ( SFEETRM.SFEETEM PIDM = 3GESTDN.3GESTDN PIDM {+) )
and { :O0LAP_BT_RunOLAP is not null
and F_registered this_ term{3FEETREM.3FEETRM PIDM, SFEETRM.3FEETRM TERM CODE)} ='T'
and substr{3FEETRM.SFEETRM TERM COLE,1,4) between :wain DD_Acad¥r.lcad¥r -5 and :wain DD_Acad¥r.licadir
and substr(3FEETRM.3FEETRM TERM CODE,5,2) =imain RE TermType.Code
and 3GESTDN.3GESTDN_TERM CODE_EFF =
{ select Max({ 3GE3TDN1.3GESTDN_TERM CODE_EFF ) "EffectTerm3tudRec”
from SATURN.SGESTDN SGBSTIN1
where SGEITDN1.3GESTDN_PIDM = SGESTDN.3GESTDN_PIDM ) )

Close

(1) Click the Close button.

xii. Click the OK button to exit the Visual Designer.

c. Click the Next button.
The Test Values window will pop up. Leave it blank and click the OK button.

e. On the Configure Measures screen, double-click on ‘InternallD’ in the Available Fields list to add
it to the Measures list and activate it.

f.  Under Display Name, type ‘Student'.

g. Under Method of Calculation, select ‘Count'.

h. Under Display Format, type ‘0’ (with no decimal places).
NOTE: You can also click the ellipsis button to open the Edit Format String window. This will display a
list of format options you can choose from.

i. Click the Next button.

j- On the Configure Dimensions page, double-click the fields in the Fields Available list box to add
them to the Available tab.
NOTE: Do not add ‘InternallD’. Start with the field immediately after it—if you followed the order
outlined above, it should be ‘Term’—and work your way down.

k. Customize the Display Name for each dimension, if you like.

I.  Clickand drag ‘Term’ from the Available tab to the Column tab.

m. Click and drag ‘EnrolIStat’ from the Available tab to the Row tab.

n. Click the Finish button.
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120.Commit and test your changes.
NOTE: You should now be able to select a year and term type on the ‘Main’ form, and use the run buttons on
‘Chart’ and ‘OLAP’ to generate charts and an OLAP cube for that data.

121.Congratulations! Your fourth Advanced DataBlock is complete. Click the Close button to exit the
DataBlock Designer.
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